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1.1 Background

Oil pollution can cause extensive damage to marine and terrestrial ecosystems.

Every year, huge quantities of oil and petroleum products enter the sea, land,

and groundwater (NAS, 2003). The pollution can come from a variety of sources,

including leakage from oil transportation, accidents on oil platforms, atmospheric

deposition, and seepage from natural seeps. Timely and accurate detection of oil

pollution in the ocean can help management and research efforts, yet it is often a

difficult task due to limited technical means in monitoring the vast ocean.

Remote sensing provides rapid, frequent, and synoptic measurement of the

ocean’s surface waters, and thus has been used widely to monitor oil pollution at

sea, as well as in lakes. The remote sensing instruments include optical, microwave,

and radar (e.g., synthetic aperture radar, SAR) sensors which can be equipped on

both aircrafts and satellites. Each of the instruments and measurement platforms

has its own advantages and disadvantages (Fingas and Brown, 1997; 2000; Brekke

and Solberg, 2005). While airborne remote sensing offers the highest resolution

(i.e., the sharpest image) and fastest response to a pollution event, it is often too

expensive to be used for operational monitoring. In contrast, satellite remote sensing

provides more frequent measurements of the ocean, hence more suitable for oil

pollution monitoring.

Among the various satellite instruments, SAR is perhaps the most often used

for oil detection at sea. The sea-surface backscattered radar signal is modulated

by the wind-induced capillary waves, and thus carries information on the surface

roughness. An ocean surface oil film has higher surface tension than water, and can

dampen the surface capillary waves, resulting in a smoother sea surface. This in
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turn reduces the backscattered radar signal, making oil contaminated areas appear

as dark patches in SAR images.

Because radar signals can "penetrate" clouds, SAR images are cloud free and

efficient for detecting the various ocean surface features. However, routine applica-

tion of SAR data is limited by its high-cost and narrow satellite swath (i.e., spatial

and temporal coverage). Depending on the measurement mode, measurement of

the same place can require days to weeks. These factors make it desirable to seek

alternatives to complement SAR observations.

There are currently several Sun-synchronous, polar-orbiting satellite ocean-colour

instruments that can measure the ocean’s bio-optical properties every day. These

include the Sea-viewing Wide Field-of-view Sensor (SeaWiFS, 1997 - present; McClain

et al., 2004), the MODerate resolution Imaging Spectroradiometer (MODIS, 1999 -

present for Terra, and 2002 - present for Aqua; Esaias et al., 1998), and the Medium

Resolution Imaging Spectrometer (MERIS, 2002 - present). While MERIS was launched

by the European Space Agency (ESA), SeaWiFS and MODIS are supported by NASA

(U.S.). Global data are available for free downloading in near real-time. In particular,

MODIS is equipped with several 250-m and 500-m resolution bands, representing

a significant enhancement over the present coastal observation capability for the

international community. The combined MODIS-Terra and MODIS-Aqua missions

cover the global ocean in any single day, thus providing great potential to develop

ocean applications.

Hu et al. (2003) used MODIS 250-m resolution data to detect and monitor oil

spills in a turbid lake in Venezuela. After removing clouds, two images per week

were obtained at no cost. The detection was possible because the high turbidity of

the lake water provided a "bright" background where the highly light-absorbing oil

films could be visualized. In the oligotrophic ocean, the water background is also

dark, making oil detection difficult. However, Hu et al. (2009) showed that when

MODIS imagery contained sun glint (i.e., specular reflection of the solar beam), high

contrast was found between oil slicks and the background water. The contrast is not

due to the difference in optical properties of the oil film and the water (as evidenced

by the lack of contrast in other glint-free images), but due to the oil-modulation

of the surface capillary waves - the same principle for SAR measurements. Indeed,

the ability of visible imagery (including those from space shuttle photos) over

sun glint regions to serve as effective radar signals was recognized decades ago

and demonstrated recently using satellite imagery (Chust and Sagarminaga, 2007).

However, its routine application has been difficult due to lack of near-daily data.

The free availability of MODIS daily data for the global oceans makes it possible to

implement a cost-effective means for oil spill monitoring.

Here, using MODIS 250-m resolution imagery and RADARSAT-1 SAR 25-m res-

olution imagery, we show several examples of how oil slicks are identified and

interpreted. Three case studies are presented here. The first covers the western

Gulf of Mexico (GOM, 18◦ – 31◦N, 98◦ – 81◦W) where numerous oil seeps exist. The
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second covers the NE GOM where a tragic oil spill event began on 20 April 2010.

The last example covers the East China Sea (ECS, 25◦ – 35◦N, 120◦ – 130◦E) where oil

pollution from terrestrial and ship discharges is well known.

1.1.1 Data Source and Processing Methods

SAR data from RADARSAT-1 (C-band radar with horizontal polarization and 100-km

swath width) were obtained during the Alaska SAR Demonstration (AKDEMO) project.

These 25-m resolution images were standard beam mode scenes, processed at the

Alaska Satellite Facility (ASF) at the University of Alaska, Fairbanks. The images

provided relative intensity of the SAR signal (in digital numbers), and were navigated

and analyzed using the software ENVI (Environment for Visualizing Images, version

4.2). The geo-referenced (or map-projected) digital images were stored in PNG

graphical format.

All MODIS data were downloaded from the NASA Goddard Space Flight Center

(GSFC) at no cost (http://oceancolor.gsfc.nasa.gov). These data are open to the

public in near real-time and do not require data subscription. The following steps

were used to generate geo-referenced MODIS images at 250-m resolution.

1. MODIS Level-0, 5-minute granules, were downloaded from NASA/GSFC;

2. MODIS Level-0 data were processed to generate Level-1b (calibrated total

radiance) data for the 36 spectral bands using the SeaWiFS Data Analysis

System (SeaDAS version 5.1). The Level-1b data were stored in computer files

in HDF (Hierarchical Data Format);

3. MODIS Level-1b data were corrected for gaseous absorption (ozone and other

gases) and Rayleigh scattering effects, resulting in the Rayleigh-corrected

reflectance:

Rrc,λ(θ0, θ,∆φ) = πLt,λ
∗(θ0, θ,∆φ)/(F0λ)× cosθ0)− Rr,λ(θ0, θ,∆φ) (1.1)

where λ is the wavelength for the MODIS band, Lt
∗ is the calibrated sensor

radiance after correction for gaseous absorption, F0 is the extraterrestrial solar

irradiance, θ0 is the solar zenith angle, θ is the sensor (viewing) zenith angle,

∆φ is the relative azimuth between the sun and the satellite, and Rr is the

reflectance due to Rayleigh (molecular) scattering. The solar-viewing geometry

is defined by (θ0, θ,∆φ), which changes from pixel to pixel. This step used

the software CREFL from the NASA MODIS Rapid Response Team. The Rr,

data of 7 MODIS bands (469, 555, 645, 859, 1240, 1640, and 2130 nm) were

stored in HDF computer files. Figures 1.1a and b show examples of the Rrc

Red-Green-Blue images using 645, 555, and 469-nm as R, G, and B, respectively.

If two consecutive 5-minute granules were required to cover the study region,

the Level-0 data were combined together before Step 2 was performed;

4. The Rrc data were geo-referenced to a cylindrical/equidistance (rectangular

or geographic lat/lon) projection for the area of interest, defined by the

(http://oceancolor.gsfc.nasa.gov)
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Figure 1.1 Map projection of the MODIS Level-1b Rrc data. (a) and (b): two
consecutive MODIS/Terra 5-minute granules on 13 May 2006. Each granule
contains Rrc data at 645 and 859 nm with a dimension of 5416 x 8120, and Rrc

data from other bands (469, 555, 1240, 1640, and 2130 nm) with a dimension
of 2708 x 4060. The RGB images were composed of Rrc at 645 (R), 555 (G), and
469 nm (B). (c): rectangular projection of the two granules to cover the area
of interest (Gulf of Mexico, from 18◦ to 31◦N and 98◦ to 81◦W). There are 440
image pixels per degree, corresponding to about 250-m per pixel.

North-South and East-West bounds. Because 1 degree is about 110 km, the

map-projected data have 440 image pixels per degree, corresponding to 250

m per image pixel. Although only the MODIS 645- and 859-nm bands have a

nadir resolution of 250 m, other bands at 500-m resolution were interpolated

to 250-m resolution using a sharpening scheme similar to that for Landsat.

The mapping software was written in-house using C++ and PDL (Perl Data

Language) with an accuracy of about 0.5 image pixel;

5. The map projected Rrc data at 645, 555, and 469 nm were converted to byte

values using a linear stretch (coefficients determined by trial-and-error), and

then used as the red, green, and blue (RGB) channels, respectively, to compose

a RGB image. Figures 1.1c shows the map projected RGB image at 250-m
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resolution from the combined 5-minute granules in Figures 1.1a and b;

6. The RGB image was loaded in the software ENVI for display and analysis.

Because of the large size, interactive stretch was used to visualize the subtle

features.

1.2 Demonstration

Because of the synoptic coverage (often >10 degrees in both N-S and E-W directions)

and medium resolution (250-m per pixel), the MODIS RGB image is very large.

Further, the colour stretch is compromised to cover both sensitivity (the smallest

difference between pixels) and dynamic range (the lowest and highest pixel values).

Thus, interactive stretching and zooming functions are required to visualize the

various image features. While several commercial software packages (e.g., ArcInfo or

Erdas Imagine, or any other software that has basic image processing capabilities)

can be used, we use the software ENVI to demonstrate how the oil-like features are

identified.

First, the RGB image is loaded into ENVI by using the "File → Open Image File"

function. Three display windows are shown (Figure 1.2 top panels): scroll, image,

and zoom. The scroll window shows the entire region at reduced resolution to serve

as a browse image; the image window shows a portion of the image at full resolution

(250-m); and the zoom image enlarges a smaller portion by 4 times.

During the initial display in ENVI, the colours are stretched linearly from 0 to

255 to cover the entire image. This often makes the subtle surface features invisible.

The image window is thus colour enhanced by a "Gaussian" enhancement, using the

menu of "Image → Enhance → Gaussian". The result is that the image window is

colour enhanced, at the price of either over-stretching or under-stretching for other

regions. The various image panels in Figure 1.2 show the before-after comparison

using the Gaussian enhancement.

What are the identified dark slicks in Figure 1.2? SAR data collected on the

same day in an adjacent region showed identical features to those appearing in the

corresponding MODIS image (Figure 1.3). Further, the MODIS image for the region in

Figure 1.3 contains low to moderate sun glint (Hu et al., 2009), and another MODIS

image collected 3 hours later over the same region, but without sun glint, shows

no features at all. All this combined evidence suggests that these dark features

are indeed due to dampened surface roughness and not due to changes in water’s

optical properties.

Several other processes, in addition to oil films, can lead to reduced surface

roughness. These include phytoplankton or fish induced surface surfactant, shoals,

and coastal freshwater jets (Alpers and Espedal, 2004). The region shown in Figure

1.3 is located in an oligotrophic ocean away from land, so these potential processes

can be ruled out. The most striking evidence is that these features are recurrent
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in the same place, and they can also be observed in other images under optimal

conditions (cloud free, with some degree of sun glint). Figure 1.4 shows two other

examples, both using ENVI’s Gaussian enhancement, where the slicks from two

different days appear to have a one-to-one relationship and originate from the same

locations. They are oriented differently due to different surface currents. The only

explanation, then, is that these surface slicks are oil films from oil seeps on the

ocean floor. Indeed, the NW GOM is well known to have numerous oil seeps and

previous studies using a variety of methods (including remote sensing) confirmed

the existence of oil seeps (McDonald et al., 1993; 1996). Thus, even without situ

validation, we can conclude that these surface features are indeed oil slicks floating

on the surface.

This application is further demonstrated using MODIS imagery to examine a

recent tragic oil spill event. On 20 April 2010, an explosion occurred on the oil

drilling rig, the Deepwater Horizon, in the northern GOM (28.74◦N, 88.37◦W). After

burning for a day, the rig sank to the 1500-m ocean floor, resulting in the largest

oil spill event in the U.S. history. The main cause of the spill was a continuously

leaking oil well, with estimates of at least 5,000 barrels per day. Various methods

have been used to assess the volume, fate, and trajectory of the spilled oil to help

mitigate the potential adverse impacts on ocean and terrestrial ecosystems. Using

the principles shown above, we processed and provided MODIS imagery in near

real-time to the management agencies and researchers, and made them available

online in Google-Earth compatible format to facilitate visualization and tracking

of the spill (http://optics.marine.usf.edu/events/GOM_rigfire, Figure 1.5). In Figure

1.5b it can be seen that among the scattered clouds there is a suspicious feature.

The feature appears like clouds, but its spectral shape is noticeably different from

clouds, with relatively lower reflectance in the blue wavelengths due to enhanced

Rayleigh scattering along the sun glint beam (the same principle behind why sunset

is reddish). The sun glint reflectance and viewing angle (relative to the mirror

direction of the sun) were estimated as 0.048 sr−1 and 12.6◦, respectively. Further,

the spatial shape and lack of shadow also indicate that the suspicious feature is oil.

Figures 1.5c and d show two other examples from the same day from MODIS-Terra

and MODIS-Aqua observations, respectively. Due to changes in the solar/viewing

geometry, the same oil slicks show positive contrast in the morning but negative

contrast in the afternoon, agreeing with what has been observed from natural oil

slicks in the GOM (e.g., Figure 1.4).

Note that the reason for using RGB images instead of individual MODIS bands

(e.g., 859 nm) is that clouds and cloud shadows can be easily visualized and ruled

out as potential oil slicks.

http://optics.marine.usf.edu/events/GOM_rigfire
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Figure 1.2 Interactive colour stretching within the software ENVI is used to en-
hance the contrast between the oil-like features and the background water. Top:
original RGB image in scroll (upper left), image (upper right), and zoom (bottom
left) display windows. Bottom: the same image after Gaussian enhancement.
Similar enhancement can be performed in other software packages.
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(a) MODIS/Terra
5/13/2006 16:45 GMT 

(b) SAR, 5/13/2006 12:14 GMT 

Figure 1.3 MODIS/Terra image (a) and SAR image (b) showing oil slicks in
the NW Gulf of Mexico (inset MODIS Red-Green-Blue figure) between 27.38◦ to
28.48◦N and 93.25◦ to 92.01◦W. The data were collected 4.5 hours apart, yet
the slick patterns appear identical. The MODIS image was coloured stretched in
ENVI using Gaussian enhancement.
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Kilometers
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(a)

Figure 1.4 MODIS/Terra images collected on 5/13/2001 (a) and 5/24/2001 (b)
showing oil slicks in the NW Gulf of Mexico as positive and negative contrasts,
respectively, against the background. The contrast change is due to different
solar/viewing geometry in the sun glint patterns (Hu et al., 2009).
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)b( )a(

)d( )c(

Figure 1.5 MODIS images showing oil slicks in the northern Gulf of Mexico
due to oil spills from a sunken oil rig (the Deepwater Horizon) on 20 April 2010.
The location of the oil rig is marked with a cross. (a) MODIS image on 22 April
2010 overlaid on a Google-Earth map shows that the oil rig is approximately
40 km southwest of the Mississippi River mouth near New Orleans, Louisiana,
U.S.A. (b) An enlarged image shows the oil slick and the surrounding clouds.
(c) MODIS image on 29 April 2010 (16:55 GMT) shows the oil slicks in positive
contrast. (d) MODIS image on the same day but at 18:30 GMT shows the same oil
slicks in negative contrast. The horizontal scale of (b)-(d) is about 120 km. More
images are available at http://optics.marine.usf.edu/events/GOM_rigfire.

1.3 Training and Questions

Three MODIS RGB images are provided on the IOCCG website (http://www.ioccg.org/

handbook/Hu_oil/) to help identify oil slicks and oil-like features. The first two cover

the GOM, collected on 13 and 24 May 2001 by MODIS-Terra. The third image covers

the East China Sea (25 to 35◦N, 120 to 130◦E), collected by MODIS-Aqua on 18 July

2008. The visualization and analysis can be performed in the following steps. We

http://optics.marine.usf.edu/events/GOM_rigfire
http://www.ioccg.org/handbook/Hu_oil/
http://www.ioccg.org/handbook/Hu_oil/
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use ENVI to describe the steps, but any other software package that has basic image

processing capabilities can also be used.

1. Open the two MODIS images in ENVI. Use the "Tools → Link → Link Displays"

to link the two images, so that they both show the identical region at the

same time. By clicking on one image and toggling "on-off", the other image is

co-registered and shown on top of the current image. This way, it is easy to

identify whether certain features on the two images originate from the same

locations;

2. Move the image window to the NW GOM, and use the Gaussian enhancement to

enhance the colour contrast. Repeat this until a satisfactory enhanced image

is obtained. This step should result in two images similar to those shown in

Figure 1.4.

The second exercise is to explore the MODIS image covering the ECS. Using the

interactive Gaussian stretch in ENVI, a colour-enhanced image should be obtained to

show dark slicks and patches near the Yangtze River mouth in the sun glint region

(Figure 1.6).

Figure 1.6 MODIS image showing surface features that appear to be oil slicks
in the East China Sea (ECS). Inset: MODIS Red-Green-Blue figure covering 25 to
35◦N and 120 to 130◦E on 7/18/2008 04:40 GMT.
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1.4 Questions

Q1: Why are the slicks brighter than the surrounding water (i.e., positive contrast)

in Figure 1.4a?

Q2: Is there a one-to-one relationship between the bright slicks (Figure 1.4a) and

dark slicks (Figure 1.4b), and do they have the same origins?

Q3: Are these dark features in Figure 1.6 oil films? If so, where do they come from?

1.5 Answers

A1: Crude oil from oil seeps strongly absorbs light and therefore should appear

darker than the adjacent waters. Then, why are the slicks in Figure 1.4a brighter?

Using MODIS data and sun-glint estimates based on solar/viewing geometry and

surface wind, Hu et al. (2009) demonstrated that if the satellite views the region

close to the "mirror direction" of the sun (< 12-14◦), positive (i.e., brighter) contrast

can result from enhanced specular reflection by the oil film. Thus, depending on

how the region is viewed by the satellite (relative to the sun), the oil slicks can show

no contrast (in glint-free imagery), negative contrast (low to moderate sun glint) or

positive contrast (strong sun glint) in MODIS imagery. The same positive contrast is

also observed in Figure 1.5a.

A2: The ENVI "Link Displays" function provides an excellent tool for tracing features

on two different images. By clicking on one image with the other toggled on or off,

one can easily visualize that the bright and dark slicks have a one-to-one relationship

and that they indeed have the same origins. The slight difference in the traced origins

between the two different days should be due to the horizontal movement during

the upwelling of the bottom oil (from 1 – 2 km deep). Nevertheless, the rough

locations can significantly narrow down the search range when in situ operations

are used to locate the exact locations of the oil seeps.

A3: It is well known that the ECS, particularly the western part, is subject to oil

pollution from a variety of sources, including land-based sewage discharge, illegal

ship discharge, and oil transportation accidents (Li and Daler, 2004; Shi et al., 2008).

Using over 600 SAR images collected over the western ECS between 2002 and 2005,

Shi et al. (2008) concluded that most of the oil-like slicks were from ship discharges.

The dark features shown in Figure 1.6 are from MODIS sun-glint regions, and they

have spatial texture (shape, size, spatial contrast) similar to oil slicks found in

MODIS sun-glint imagery in the western GOM. Therefore, in the absence of an in

situ validation effort, and considering their proximity to the shipping routes, we can

conclude that these dark features are very likely oil slicks from ship discharge. Note
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that without background information or a priori knowledge of the study region, the

difficulty in recognizing oil slicks from suspicious features also holds true for SAR

imagery (Alpers and Espedal, 2004). In this regard, the performance of the MODIS

sun-glint imagery in detecting oil slicks is comparable to that of SAR, except that

MODIS has a lower resolution (250-m versus 25 or 10-m for SAR) and is restricted

by clouds.

1.6 Discussion and Summary

The three case studies demonstrated here (one for natural oil seeps in the western

GOM, one for a tragic oil spill event in the eastern GOM, and one for ship or river

discharges in the western ECS) clearly show the potential of MODIS imagery in

detecting oil slicks in both oligotrophic and turbid ocean waters, using MODIS

images that are cloud free and that contain some degree of sun glint. In turbid

coastal waters where water reflectance is high, observation of oil slicks does not

require sun glint, as shown by Hu et al. (2003) for Lake Maracaibo, Venezuela.

Likewise, when surface oil slicks are thick, sun glint is not required either (Figure

5d). However, such potential of MODIS should not be over-emphasized compared

with other means (e.g., SAR detection) because 1) the MODIS visible and near-IR

bands cannot penetrate clouds, and the method is useless for cloud contaminated

image pixels; and 2) for oligotrophic oceans and thin slicks, some degree of sun

glint is required to detect the changes in surface roughness, and this requirement

limits its use in high latitude regions. Finally, when sun glint is required for the

observations, all limitations that apply to SAR applications for oil detection (e.g.,

optimal wind speed, difficulty in differentiating the various dark features) also apply

to MODIS imagery because they are based on the same principles (i.e., changes in

surface roughness).

However, MODIS has the advantage of greater coverage and no data cost, thus

enabling a potentially quasi-operational system to be implemented for routine

applications, and fast response in case of oil spill events. MODIS has a swath width

of about 2300 km, and the two MODIS instruments onboard the Terra (morning

pass) and Aqua (afternoon pass) satellites make the spatial/temporal coverage at

moderate resolution (250-m) unprecedented by any in-orbit satellite instruments. In

this regard, for regions with a potential for heavy oil spills, a MODIS-based system

should be implemented. Indeed, the most recent oil spill event in the Gulf of Mexico

(Figure 5) provides an excellent example as to how a MODIS-based, quasi-operational

system can contribute to monitoring and mitigation of oil spills. MODIS provided

near daily oil spill coverage for most of the NE GOM during the first month of the

spill event (21 April to late May 2010). When cloud cover increased from late May

towards the summer, SAR data from several sources were combined with MODIS

observations to improve the coverage. The advantage of combining more synoptic
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and frequent MODIS data with cloud-free SAR data in oil spill monitoring has been

clearly demonstrated in this case.

In summary, oil films on the sea surface modulate the surface roughness (capil-

lary/gravity waves), and thus can be differentiated from their surrounding waters in

MODIS sun glint imagery. This ability is demonstrated by two case studies where oil

slicks from natural seeps and possibly ship discharges are identified. When oil films

are thick, their optical properties (light absorption and surface Fresnel reflection)

can make them well distinguished from the surrounding waters, as shown in the

recent GOM oil spill case study. Because of the free availability of the MODIS 250-m

data since 2000, a monitoring system at low cost can be established, in principle, for

any part of the global oceans where sun glint is frequently observed. Combined with

SAR observations, such a system may significantly enhance our capability to monitor

oil spills in most of the global oceans. Automated delineation and quantification

of oil slicks (e.g., thickness) using texture analysis as well as image segmentation,

however, still requires further research.
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